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This document covers information that will help you install and use Microsoft Image Composer version 1.5. Please read 
this entire document.

To view this Readme file in Windows WordPad, maximize the WordPad window. To print this Readme file, open it in 
WordPad or another word processor, and then click Print on the File menu.

Installation

System Requirements

To use Microsoft Image Composer 1.5, you need:
· 486/66 processor or higher (Pentium processor recommended)
· Windows 95 or Windows NT Workstation 4.0
· 16 MB of memory (32 MB recommended) 
· 20-254 MB of available hard-disk space required; 30-44 MB required for typical installation, depending upon 

configuration
· 640x480 16-bit color (Super VGA, 800x600 24-bit TrueColor with 2 MB of video memory recommended)
· Microsoft Mouse or compatible pointing device. Microsoft IntelliMouse is supported.

Microsoft Image Composer options: 
· Windows-compatible tablet with mouse emulation for basic mouse support, or WinTab-compatible tablet for Full 

Pressure support 
· TWAIN-compatible scanners or digital cameras

Special Notes and Known Problems for Installation

· At the end of an install or uninstall, you may be presented with a dialog prompting you to either restart Windows or 
exit setup. ALWAYS choose to restart Windows. Doing otherwise can result in an incomplete installation and make 
it difficult to re-install correctly.

· Microsoft Image Composer 1.5 does not support Microsoft Windows NT 3.51.
· Installing the German or Japanese versions of Image Composer 1.5 to an operating system other than German or 

Japanese, respectively, can cause undesirable results. This type of installation should be avoided.
· You may not be able to properly install Image Composer 1.5 using an NEC 3X CD-ROM. 
· Microsoft GIF Animator is now included in the Typical and Custom install options of Microsoft Image Composer 

1.5.  If you have a previous version of Microsoft GIF Animator, you will be prompted that the previous version will 
be deleted.

· All user settings are preserved when upgrading from any of the 1.0 versions of Microsoft Image Composer to 
version 1.5.

Known Problems for Installation on Far East OS (except Japanese) 

· Microsoft Image Composer 1.5 installs WordArt 3.0 (English) as part of its Typical and Custom install. WordArt 
3.0 (English) does not function properly under Far East operating systems. If you have an older version of WordArt 
already installed on your system, including the one that shipped with either Microsoft Office 95 or Microsoft Works 
4.0, it will be overwritten. You can override the installation of WordArt by using the Custom  Setup option for Image
Composer 1.5.  Clear the WordArt check box to prevent WordArt 3.0 from being installed.

Sample Sprites



Microsoft Image Composer contains a lot of useful sample sprites, which include Web Art Samples (buttons, bullets, 
backgrounds, horizontal rules, navigational controls, page counters) and Photo Sprite Samples (photo realistic objects). 
You have the option of installing Web Art Samples and Sprite Samples when you choose the Custom Install dialog box. 
Since these files will take up a large amount of disk space, we recommend that you keep them on the compact disc and 
use them from the compact disc.

You can browse thumbnail sketches of all the samples without installing the samples. Simply click Sample Sprites 
Catalog on the Help menu. This option  will always be on the Help menu whether you install the Compact, Typical, or 
Custom version of Microsoft Image Composer.

Some of the sample images that were available with Microsoft Image Composer 1.0 and 1.0a are no longer available in 
Microsoft Image Composer 1.5.

Uninstalling

Microsoft Image Composer should be uninstalled by using either the Microsoft Image Composer 1.5 Setup program item 
or the Add/Remove Programs icon in the Control Panel. Uninstalling by any other means (for example, by deleting 
directories or files) may cause system instabilities or problems for future installation of this product.

If you use "Add/Remove Programs" to remove Microsoft Image Composer, you will have to restart Windows (95 and 
NT). You will not be prompted to insert your CD.

Online Help

The online Help file in Image Composer contains reference information as well as step-by-step procedures. To discover 
the extent of the Image Composer features, explore the visual elements in the online Help file, or use context-sensitive 
Help directly in the user interface.

Be sure to check out these Help topics:
· Learning Image Composer – includes an introduction, a new tutorial and a "What's New" 
· Common Tasks – help on 10 of the most common tasks Image Composer users do

Special Notes

· Many tools and effects have changed their names and/or locations from the previous version of Image Composer. In 
addition, there are a few effects that are no longer in the product. Please refer to the "Changed names" Help topic for 
further details.

· The file format has not changed between version 1.0 and version 1.5. However, Microsoft Image Composer 1.5 
introduces a few new objects that version 1.0 does not know about. You can open a version 1.5 file in version 1.0.  If 
the 1.5 file contains any of the new objects, Microsoft Image Composer 1.0 will interpret them as regular sprites. The
object properties are maintained if the image is then saved in version 1.0 and subsequently reopened in version 1.5. 

· Microsoft Image Composer has improved its plug-in support. The plug-in filters (and version #s) that have been 
tested are: Alien Skin - Eye Candy (v3.0); Andromeda Series 1 Photography Filters (v1.6); MetaTools KPT 
Convolver (32-bit only); MetaTools KPT (v3.0); Impressionist (v1.0 - ships with Microsoft Image Composer). You 
may find that many of your other favorite plug-ins will work, too. Before experimenting with plug-ins, you should 
save your work. While many plug-ins will work fine, there are some which may cause Image Composer 1.5 to 
become unstable or unexpectedly terminate.

· Gamma processing has been changed in this version of Image Composer. Please refer to the "Gamma tab" Help 
topic for more details.

· You can edit frames of a GIF animation by using the Microsoft GIF Animator and dragging the frames to and from 
Image Composer. If you attempt to open a GIF animation directly into Image Composer, only the first frame of the 
animation is loaded.

· If your display device appears to need updating, use the display refresh function, assigned to function key F5. For 
example, you can redisplay the composition when viewing it with a custom color palette. 



· If you are creating text that is the same color as the composition space, it will be difficult to edit, as it will appear as
though the text sprite edit box is empty. You may want to temporarily change the color of the text you are entering 
until the content of your text is what you want. Then change the color back to the desired color.

Known Problems

· Inserting some OLE objects using the Object command on the Insert menu will cause undesirable results and may 
cause your system to hang. In this situation, press  <Ctrl><Alt><Del> to end the Image Composer task. You should 
reboot as soon as possible because your system is now unstable.

· Microsoft Image Composer does not support the Progressive JPEG file format. If you open this type of file, the error
message "unknown format of format variant" displays. Resave the image as a standard JPEG file in another 
application before trying to reopen it in Image Composer. 

· Some plug-in filter effects, such as a glow-type effect, might affect the area outside the edge of the sprite. In this 
context, it may be necessary to extend the bounding box of the selected sprite to accommodate the plug-in effect. For
more information, see the Help topic "Extending the bounding box of a sprite."

· It is possible to insert or create a shape that is less than 3 pixels by 3 pixels. However, it cannot be scaled (resized), 
as 3 x 3 is the minimum required sprite size allowed for scaling operations.

· Resizing a sprite can sometimes cause the edge of the sprite to appear blurred. There will be extra "whitespace" 
between the sprite and its bounding box in this context. You can use the crop tool to eliminate this extra space. 

· Making an OLE-based sprite (one created using the Insert Object command) larger can sometimes cause it to 
become transparent. If this happens, turn off object smoothing by clicking Object Smoothing on the Edit menu. 

· You may have unexpected results if you copy or cut an image from Microsoft Image Composer and paste it into 
Microsoft Word, and then copy it from Microsoft Word and use Paste Special (Smoothed Enhanced Metafile) to 
paste it back into Microsoft Image Composer. The result may be an image that is roughly twice the size of the 
original. To fix this, you need to resize the image back to its intended size.

· Some objects that appear in the list on the Insert Object dialog box may not render properly or may not render at all.
This is most likely to happen with certain ActiveX controls. If this happens, select a different object type.

· Some attachment types cannot be dragged from Microsoft Outlook directly into Image Composer. The workaround 
is to use copy/paste special or drag/drop special and specify the OLE object type explicitly.

· Text may appear clipped when it is rendered as a sprite. This is most likely to appear when an italic font is used or if
underline is turned on. Try adding a space or a carriage return to the end of the word or line to "pad" the clipped 
character(s). 

· Anytime a text-based sprite is resized or rotated and then re-edited, the point size of the font is interpolated based on
the size of the bounding box. This can sometimes cause unpredictable results during the re-edit. This will most often 
manifest itself as text becoming much larger than it previously was and/or the bounding box becoming 
proportionately bigger. You will have to manually resize the text and/or edit box as necessary.

· You cannot resize the text edit field larger than your display size. For example, if your display resolution is set to 
640 x 480, you cannot create a text edit field, and thus a text sprite, larger than 640 x 480. 

· Text can only be edited at 100% zoom. A hint dialog tells you that you must set your zoom to 100% to edit or insert 
text.

· Image Composer supports the Microsoft IntelliMouse, but IntelliMouse use is not documented in the online Help. 
To pan the workspace, hold down the wheel button and move the IntelliMouse. Roll the wheel to pan the workspace 
vertically. Press the ALT key while rolling the wheel to pan the workspace horizontally. To zoom in or out, hold 
down the CTRL key and roll the wheel. Pressing the SHIFT key then rolling the wheel will cycle through selection of
sprites in the workspace.

· The keyboard shortcut for Panning is not documented in the "Keyboard Shortcuts" Help topic. PgUp and PgDn will 
pan the workspace vertically. Holding down the CTRL  key and pressing PgUp and PgDn will pan the workspace 
horizontally. 

· The Opacity control on the Cutout Tools tab of the Cutout palette also affects the opacity of the Select Color Region
tool on the Select Color Region tab of the same palette.

· When entering a negative number into an edit box that supports it, the negative sign must come immediately before 
the number, such as "-100". Entering the negative sign anywhere else in the number causes the input to be invalid.

· Creating buttons with long text labels at a large point size can cause the text to be displayed at a different point size.
If this happens, decrease the point size of your button text or shorten the text label.

· Using certain tools on palettes, such as the Apply button for the resize controls on the Arrange palette, will cause the
selected sprite to lose focus. Reselect the sprite to give it focus again. 



· If you have a multiple selection consisting of a group and a single sprite, some Apply buttons will be enabled even 
though you cannot perform the Apply operation. Clear the multiple selection to ensure proper application of the 
desired tool or effect.

· Button textures support only BMP and JPG file formats. To use another type of object as a button texture, convert it 
to one of these types.

· When using a Pentium Pro CPU, single-pixel artifacts may appear in your workspace when your display is set to 
either 24-bit or 32-bit color depth. This is a problem with the video card driver. Try obtaining an updated video card 
driver from the manufacturer.  Pressing <F5> will temporarily refresh your display.

· Saved GIF files sometimes appear over-dithered using a predefined color format. You may get better results by 
generating a palette from the selection and using that palette when saving.

· If you try to insert a large number of files using the Insert From File command, Image Composer may fail to insert 
all the images. To work around this limitation, do one of the following: select the files in the Windows Explorer and 
drag and drop them directly into Image Composer, or choose fewer files in the Inserts an Image File dialog box.

· If you have a file name that has a leading space, add single quotes around the file name (' Myfile.mic' for example) 
when you type its name into the Open dialog box.

· When scanning, make sure you have a minimum of 5 MB of free disk space. Without sufficient disk space, your 
scanning results will be unpredictable and you could lose data because of low system resources.

· If you change your default printer while Image Composer is running, you might need to exit and restart Image 
Composer for the change to be recognized.

· Image Composer supports Photoshop files. Image Composer can open any version of a Photoshop file, however, it 
saves only as Photoshop version 3.0 or higher. Adjustment layers in a Photoshop 4.0 file are not supported by 
Microsoft Image Composer. 

· In Photoshop, if you save an image with no alpha channel as a 32-bit TGA file, it will appear transparent in your 
Image Composer compositions. Photoshop sets the alpha channel to 0 (transparent) instead of setting it to 255 
(opaque). To have the image appear opaque, save the file in Photoshop as a 24-bit TGA file.

· Attempting to insert multiple shortcut links to valid image files will result in an "invalid format" error. Selecting 
only one shortcut link at a time will function properly.

· Image Composer 1.5 does not support Fax-format TIF files. Upon installation, Image Composer 1.5  takes the TIF 
file extension if it is not already taken. Double-clicking on the fax-based TIF will launch Image Composer and 
present the "image file is stored in an unsupported format or format variant" error. To open a fax-based TIF, you will 
need to save the file and open it with an application such as the Wang Imaging program.


